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chapter 1

Introduction to Pro Tools AVoption and 
AVoption XL
AVoption and AVoption XL combine the power-
ful audio post-production features of Pro Tools 
with integrated support for the import, capture, 
and playback of Avid video media.

AVoption Components
AVoption consists of software and two Avid 
video cards that you install in a Pro Tools audio 
system. The Digidesign audio hardware provides 
digital audio recording, editing, mixing, and 
processing. The Avid video hardware provides 
video capture and import, full-screen video 
playback on an external PAL or NTSC monitor, 
video playback in an on-screen window, and 
professional quality video compression.

AVoption Capabilities

AVoption lets you:

• Import and capture multiple NTSC or PAL 
video clips to the Movie track.

• Play the Movie track with near sample-accu-
rate precision against audio tracks in a 
Pro Tools session.
Chap
• Spot or Slip the Movie track to a new time 
code location, and spot audio to the video 
track.

• Spot individual video clips to new locations in 
the Movie track.

• View video edits and clip definitions in the 
Movie track.

• View the Movie track as a series of picture 
frames.

• Play video on an external NTSC or PAL moni-
tor.

• Play video in a floating window on your com-
puter monitor.

You can also:

• Import MFM (Media File Manager format) or 
MSM (Media Stream Manager format) video 
files created on Avid systems, such as Media 
Composer, Xpress/Mac, and AudioVision into 
the Movie Track of a Pro Tools session.

• Capture MSM format video media in the 
Movie Track of a Pro Tools session, while re-
cording audio simultaneously.
ter 1: Introduction to Pro Tools AVoption and AVoption XL 1
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AVoption XL Components
AVoption XL consists of software, a PCI card 
that you install in a Pro Tools audio system, and 
an external I/O box that connects to the PCI 
card. The Digidesign audio hardware provides 
digital audio recording, editing, mixing, and 
processing. The Avid video hardware provides 
video capture and import, full-screen video 
playback on an external PAL or NTSC monitor, 
professional quality video compression, and the 
capability to record and play back uncom-
pressed video.

AVoption XL Capabilities

AVoption XL lets you:

• Import and capture multiple NTSC or PAL 
video clips to the Movie track.

• Play the Movie Track with near sample-accu-
rate precision against audio tracks in a 
Pro Tools session.

• Spot or Slip the video track to a new time code 
location, and spot audio to the video track.

• Spot individual video clips to new locations in 
the Movie track.

• View video edits and clip definitions in the 
Movie Track.

• View the Movie track as a series of picture 
frames.

• Play video on an external NTSC or PAL moni-
tor.
AVoption & AVoption XL Guide
You can also:

• Import JFIF video media files from Meridien-
based Avid systems (Mac or Windows) such as 
Media Composer, Symphony, and Xpress into 
the Movie Track of a Pro Tools session, while 
recording audio simultaneously.

• Capture JFIF format video media in the Movie 
Track of a Pro Tools session.

FilmFrame
The FilmFrame™ option enables 24 fps support 
in AVoption. With FilmFrame installed and au-
thorized, you can import and play back Avid 
Film Composer media files. For more informa-
tion on FilmFrame, contact your Digidesign 
dealer or visit the Digidesign Web site.



         
chapter 2

AVoption Hardware Overview
AVoption hardware consists of two cards: an 
Avid Broadcast Video Board (ABVB), and a Janus 
Advanced JPEG Compression card. These cards 
connect with a ribbon cable. The ABVB breakout 
cable is also included.

AVoption Hardware 
Capabilities
AVoption hardware:

• Receives composite or component video sig-
nal.

• Digitizes incoming video.

• Compresses digitized video using advanced 
JPEG compression.

• Outputs composite and component video sig-
nals.

• Connects to a second VGA monitor (optional) 
for displaying the Movie window.
Avid Video Resolutions (AVR)

The ABVB captures and plays back video media 
with JPEG compression technology, expressed 
as Avid Video Resolution (AVR) levels, in the 
MSM media format (Media Composer 7.x com-
patible). AVoption can import both MSM video 
and MFM video, which is generated by AudioVi-
sion 4.x and Media Composer 6.x.

AVR levels dictate the amount of JPEG compres-
sion, which determines image quality and stor-
age requirements for digitized video.

The following resolutions are available:

• Single-field – AVR 2s, AVR 3s, AVR 4s, AVR 6s, 
AVR 8s, AVR 9s

• Two-field – AVR 12, AVR 70, AVR 70B, 
AVR 71, AVR 75, AVR 75B, AVR 77

Lower numbered AVR levels require less hard 
drive space, but provide lower resolution than 
higher numbered AVR levels.

The lowest resolution is AVR 2m. The maxi-
mum resolution is AVR 77 and is considered to 
be broadcast quality.
Chapter 2: AVoption Hardware Overview 3
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JPEG Compression and Storage

JPEG compression varies according to the com-
plexity of the footage. For example, a medium 
shot of a talking head with a simple background 
would compress more (using less disk space) 
than a panning shot of a stadium full of people.

The following tables list the approximate 
amount of video storage, in minutes per gi-
gabyte, required for each AVR level.

Storage for AVR 2s – AVR 9s

AVR 
level

30/25 FPS 
Storage
(Minutes/GB)

24 FPS 
Storage
(Minutes/GB)

AVR 2s 40–74 50–93

AVR 3s 32–57 40–71

AVR 4s 19–40 24–50

AVR 6s 11–33 14–41

AVR 8s 5–13 6–16

AVR 9s 3–6 4–7

Storage for AVR 12 and AVR 70 – AVR 77

AVR 
level

30/25 FPS
Storage
(Minutes/GB)

AVR 12 18–34

AVR 70
AVR 70B

5–11

AVR 71 4–11

AVR 75
AVR 75B

3–8

AVR 77 2–6
AVoption & AVoption XL Guide
Required Hardware
To install and use AVoption, you must first in-
stall a currently supported version of 
Pro Tools 24 or Pro Tools 24 MIX hardware. 
Other hardware required for AVoption is listed 
in this section, along with system requirements 
for AVoption.

Supported Computers
• Power Macintosh 9500

• Power Macintosh 9600

• Power Macintosh G3 (Blue & White)

• Power Macintosh G4

If you are using a Blue & White G3 or a G4, a 
qualified expansion chassis is required.

Older G3 Macintosh systems (beige) are not sup-
ported.

For an up-to-date list of Digidesign-quali-
fied computers, video cards, SCSI accelera-
tors, and hard drives, visit the Digidesign 
Web site (www.digidesign.com/compato).



                       
Minimum System Requirements

Sync Hardware

Synchronization Peripheral

AVoption requires a Universal Slave Driver 
(USD).

Sync Source

For accurate synchronization during capture 
and playback, Pro Tools and AVoption must 
both be locked to video black burst.

Minimum Pro Tools AVoption System Requirements

Item Minimum Requirement

Computer Power Macintosh 9500
Power Macintosh 9600
Power Macintosh G3 (Blue & 
White)
Power Macintosh G4

Pro Tools audio 
hardware

Pro Tools 24
Pro Tools 24 MIX
Pro Tools 24 MIXplus

PCI Expansion 
Chassis (Blue & 
White G3)

Magma 13–slot

SCSI accelerator ATTO ExpressPCI Dual-Channel 
(Other SCSI accelerators may 
be approved. Check the Digide-
sign Web site for the latest 
compatibility information.)

SCSI hard drives at least 2 approved SCSI hard 
drives

Sync peripheral Universal Slave Driver (USD)
Storage Hardware

SCSI Accelerators

To support the high transfer rates required by 
AVoption audio and video, the ATTO Express 
PCI Dual-Channel SCSI Accelerator (or other 
AVoption-qualified SCSI accelerator) is required, 
with audio drives connected to one channel and 
video drives connected to the other channel.

SCSI Hard Drives

Using Two Hard Drives

For scenarios that do not require a high audio 
track count or a very long video segment, use 
two hard drives. In this scenario, one drive is 
used to record, import, and play back audio 
data, and the other is used to do the same for 
video. 

Using More Than Two Hard Drives

To get the highest possible performance from 
your AVoption system, you can use more than 
two hard drives. In this scenario, you can use up 
to four hard drives for audio data and up to four 
hard drives for video data.

Audio AVoption can use multiple hard drives to 
store audio data. You should allocate audio 
tracks to different hard drives manually. “Round 
robin” disk allocation is not recommended in a 
system that includes video drives.

Video AVoption can capture a contiguous video 
track to multiple hard drives. This is useful if the 
length of your video session exceeds the 2 GB 
Mac OS file size limit, or the storage space avail-
able on a single drive. For example, 50 minutes 
of video material, using AVR 77 compression, 
requires between 9 GB and 25 GB of storage 
Chapter 2: AVoption Hardware Overview 5
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space. To store this much video, you need be-
tween one and three 9 GB hard drives. The 
video is automatically split by AVoption into 
several linked files of less than 2 GB on each 
disk.
AVoption & AVoption XL Guide



           
chapter 3

AVoption XL Hardware Overview
AVoption XL consists of two hardware compo-
nents: a Meridien Digital Media Board that in-
stalls in a PCI slot in your computer, and a Me-
ridien I/O Box that connects to the card in your 
computer. A Video I/O Board, installed in the 
Meridien I/O Box, provides video inputs and 
outputs from your computer to the rest of your 
video equipment. 

AVoption XL Hardware 
Capabilities
AVoption XL hardware:

• Receives composite, component, S-video, or 
(optional) SDI video signal.

• Digitizes incoming video.

• Compresses digitized video using advanced 
JFIF compression.

• Outputs composite, component, S-video, and 
(optional) SDI video signals.

• Captures and plays back uncompressed video.
JFIF Video Compression

The Meridien board captures and plays back 
video media in JPEG File Interchange Format 
(JFIF). JFIF compression levels provide variable 
levels of compression for your video project, de-
pending on the recording input selected. The 
available JFIF resolutions are:

• Single field – 15:1s, 4:1s, 2:1s

• Two fields – 20:1, 10:1, 3:1, 2:1, 1:1 (uncom-
pressed)

Higher JFIF compression ratios require less stor-
age space but provide decreased video resolu-
tion than lower compression ratios.

The lowest JFIF resolution is 15:1s. The maxi-
mum resolution is 1:1 (uncompressed).

JFIF Compression and Storage

JFIF compression levels vary slightly, depending 
on the video input selected.

1:1 (uncompressed) data storage levels are not 
approximate. The amount of data required to 
store 1:1 video is always the same, regardless of 
the video input used.
Chapter 3: AVoption XL Hardware Overview 7
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The following tables list the approximate 
amount of video storage, in megabytes per sec-
ond, required for each JFIF compression level.

Storage for Single-Field JFIF

JFIF 
level

30/25 FPS 
Storage
(MB/second)
(approximate)

15:1s .7

4:1s 2.7

2:1s 5.5

Storage Required for Two-Field JFIF 

JFIF 
level

30/25 FPS 
Storage
(MB/second)
(approximate, 
except 1:1)

20:1 1.1

10:1 2.2

3:1 7.3

2:1 11

1:1 22
AVoption & AVoption XL Guide
Required Hardware
To install and use AVoption XL, you must first 
install a currently supported version of 
Pro Tools 24 or Pro Tools 24 MIX hardware. 
Other hardware requirements and system re-
quirements for AVoption XL are listed in this 
section.

Supported CPU’s
• Power Macintosh 9600

• Power Macintosh G3 (Blue & White)

• Power Macintosh G4

Older G3 Macintosh systems (beige) are not sup-
ported.

Minimum System Requirements 

3:1 Video Compression or Higher

For an up-to-date list of Digidesign-quali-
fied computers, video cards, SCSI accelera-
tors, and hard drives, visit the Digidesign 
Web site (www.digidesign.com/compato).

Minimum AVoption XL System Requirements

Item Minimum Requirement

CPU Power Macintosh 9600, 
Blue & White G3, or G4

PCI Expansion 
Chassis

Magma 13-Slot

SCSI accelerator Qualified SCSI accelerator 
(ATTO EPCI-DC or Digidesign 
SCSI 64)

SCSI hard drives Qualified drives are required; 
see the Digidesign Web site 
for more information.

Sync peripheral Universal Slave Driver (USD)



                    
2:1 Video Compression or 1:1 
(Uncompressed)

Sync Hardware

Synchronization Peripheral

AVoption XL requires a Universal Slave Driver 
(USD).

Sync Source

For accurate synchronization during capture 
and playback, a house sync source or black burst 
generator is required.

Minimum AVoption XL System Requirements

Item Minimum Requirement

CPU Power Macintosh 9600, 
Blue & White G3, or G4

PCI Expansion 
Chassis

Magma 13-Slot

SCSI accelerator 
(video)

Qualified SCSI accelerator
(ATTO EPCI-UL2D LVD Acceler-
ator required for 2:1 or 1:1 
video compression)

SCSI accelerator
(audio)

Qualified SCSI accelerator
(ATTO EPCI-DC or Digidesign 
SCSI 64 required for 2:1 or 
1:1 video compression)

SCSI hard drives Qualified drives are required; 
see the Digidesign Web site 
for more information.

Striped hard drives A 2-way stripe is required for 
2:1 compressed video.
A 4-way stripe is required for 
uncompressed (1:1) video.

Sync peripheral Universal Slave Driver (USD)
Storage Hardware

SCSI Accelerators

To support the high transfer rates required by 
AVoption XL video, a qualified SCSI accelerator 
is required, with audio drives connected to one 
channel and video drives connected to the other 
channel. For 2:1 compression or 1:1 uncom-
pressed video, 2 SCSI accelerators are required.

SCSI Hardware and Drives with 
Video Compression Level 3:1 or 
Higher

If you are using 3:1 video compression or higher 
at all times, then your system requires only a 
single dual channel SCSI accelerator, the ATTO 
EPCI-UL2D or EPCI-DC, or the Digidesign 
SCSI 64, with audio drives connected to one 
channel and video drives connected to another.

Using Two Hard Drives

For scenarios that do not require a high audio 
track count or a very long video segment, you 
may use two hard drives.

In this scenario, one drive is used to record, im-
port, and play back audio data, and the other is 
used to do the same for video.

Using More Than Two Hard Drives

To get the highest possible performance from 
your AVoption XL system, you can use more 
than two hard drives. In this scenario, you can 
use many striped hard drives for audio and 
video data. Striped volumes appear to 
AVoption XL as a single volume. 
Chapter 3: AVoption XL Hardware Overview 9
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Audio AVoption XL can store audio data to mul-
tiple hard drives. You should allocate audio 
tracks to different hard drives manually. “Round 
robin” disk allocation is not recommended in a 
system that includes video drives.

Both of these options are covered in detail in the 
Pro Tools Reference Guide.

Video AVoption XL can capture a contiguous 
video track to multiple hard disks. This is useful 
if the length of your video session exceeds the 
storage space available on a single drive. For ex-
ample, 26 minutes of video material, using 3:1 
compression, requires approximately 11.1 GB of 
storage space. To store this much video, you 
need two 9 GB hard drives.

SCSI Hardware and Drives with 
Video Compression Level 2:1 or 
1:1

If you are using 2:1 or 1:1 video compression, 
your system requires two SCSI accelerators: the 
ATTO EPCI-UL2D LVD accelerator, and the 
ATTO EPCI-DC or Digidesign SCSI 64. In this 
scenario, video drives are connected to the 
EPCI-UL2D, and audio drives are connected to 
the EPCI-DC or SCSI 64. Or, two EPCI-DC’s may 
be used for this scenario.

Striped Drive Requirements

Striped drives are configured so that multiple 
hard drives behave as if they are one hard drive. 
This makes higher data throughput possible. 4-
way striped drives (4 drives acting as one) are re-
quired when capturing, importing, or playing 
uncompressed (1:1) video. 2-way striped drives 
(2 drives acting as one) are required when cap-
turing, importing, or playing 2:1 compressed 
video.
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2-way striped drives should be connected in 
pairs to the EPCI-UL2D accelerator, with 1 drive 
connected to each channel. 

4-way striped drives should be connected in 
pairs to the EPCI-UL2D accelerator, with 2 or 
more (in even amounts) drives connected to 
each channel. 

Pro Tools and AVoption XL do not support 
striped audio drives.



                     
chapter 4

Installing AVoption
This chapter discusses the installation of AVop-
tion software and hardware.

Installing a New AVoption 
System
If you do not already have currently supported 
Pro Tools TDM hardware installed, you must in-
stall AVoption as a new system. 

To install a new AVoption system:

1  Install Pro Tools software using the Pro Tools 
Installer CD-ROM. The first time you launch 
Pro Tools, you are prompted to enter your au-
thorization code, which is included in your 
TDM Software Installation Guide.

2  Install AVoption software. See “Installing 
AVoption Software” on page 12.

3  Install Pro Tools and AVoption hardware. 

• Determine the proper PCI slots for your instal-
lation. See Appendix A, “Slot Configurations 
for AVoption.”

• Install Pro Tools hardware using the instruc-
tions in the TDM Installation Guide.

• Install AVoption hardware. See “Installing 
AVoption Hardware” on page 13.
Installing AVoption as an 
Upgrade
If you have currently supported Pro Tools TDM 
hardware installed in your system, then you can 
install AVoption as an upgrade. 

To install AVoption as an upgrade:

1  Install AVoption software. See “Installing 
AVoption Software” on page 12.

2  Install AVoption hardware. Determine the 
proper PCI slots for your installation using 
Appendix A, “Slot Configurations for AVop-
tion.” You may need to rearrange previously in-
stalled Pro Tools hardware. To install AVoption 
hardware, see “Installing AVoption Hardware” 
on page 13.

You must have the latest version of 
Pro Tools (included in the AVoption pack-
age) installed before you install AVoption.
Chapter 4: Installing AVoption 11
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Installing AVoption Software
AVoption includes the following software:

• Pro Tools Installer CD-ROM

• AVoption Installer CD-ROM

• AVoption Authorizer diskette

The Pro Tools Installer CD-ROM is provided in 
case you need to update your Pro Tools to the 
latest version. AVoption requires Pro Tools 5.0 
or later. Owners of Pro Tools versions earlier 
than 5.0 will need to contact Customer Service 
for upgrade information. 

AVoption is copy protected with a key disk. Af-
ter you install the software from CD-ROM, the 
Authorizer diskette permits you to authorize 
and use a single copy of AVoption. 

AVoption software is installed in a specific loca-
tion in your System Folder, and should not be 
moved or altered. The Authorizer diskette per-
mits you to reclaim authorization from your 
hard drive if you want to install AVoption on a 
different hard drive, or if you want to re-initial-
ize or format your drive.

To install AVoption software:

1  Insert the Pro Tools Installer CD-ROM in your 
CD-ROM drive.

2  Follow the installation instructions to install 
AVoption.
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To authorize or deauthorize AVoption:

1  Insert Authorizer diskette into floppy drive. 
(Pro Tools should NOT be launched during this 
process)

2  Click Authdeauthorizer in the pop-up win-
dow that appears. 

3  Click Set-up Authorizer or Deauthorizer.

4  Choose Remove or Authorize (If you are re-
moving an application and a”?” appears over 
the application icon, indicates that the diskette 
you inserted is not the one you originally used 
to authorize this application. You should see a 
gold key icon. If you continue through the de-
authorization process with a “?” will deautho-
rize the application but not credit an 
authorization back to the diskette for your next 
installation.)

5  Select disk location and click Remove or Au-
thorize. 

6  Quit.

Installing FilmFrame

FilmFrame is optional, and copy protected with 
a key disk. If you purchase this option, you will 
receive a FilmFrame Authorizer diskette that 
permits you to authorize and use this option.

To authorize FilmFrame:

■ Insert the Authorizer diskette into your floppy 
drive, and authorize FilmFrame.



Installing AVoption Hardware

AVoption PCI Slot Configurations

To install your AVoption hardware, first deter-
mine the PCI slots where you will install the 
hardware. For detailed information, see 
Appendix A, “Slot Configurations for AVop-
tion.”

Audio Hardware

Refer to the TDM Hardware Installation Guide for 
audio hardware installation information. You 
may be required to move hardware that is al-
ready installed to new PCI slot locations in your 
computer or expansion chassis, based on the in-
formation in Appendix A, “Slot Configurations 
for AVoption.”

Installing AVoption Video 
Hardware

To install AVoption video hardware:

1  Unplug and open your Macintosh computer 
or your Magma expansion chassis according to 
the instructions included with it.

2  Release any static electricity by touching the 
power supply of the CPU, or another grounded 
item.
3  Remove the ABVB card from the antistatic 
bag, being careful to handle it only by the edges.

4  Line up the ABVB card with the installation 
slot, and slide the card gently into place so the 
PCI connector is lined up with the PCI slot. 

5  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI slot.

6  Repeat this process for the Janus Advanced 
JPEG card, making sure that you place it in the 
proper slot. 

ABV card and ribbon cable

PCI card alignment and installation
Chapter 4: Installing AVoption 13
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7  Attach the ribbon cable from the ABVB board 
to the connector on top of the Janus Advanced 
JPEG card by aligning the cable end with the 
connector, and gently pressing it onto the card 
until it clicks into place.

8  Close the computer or expansion chassis.

ABVB card and Janus Advanced JPEG card installed

...................

ABVB card

Janus card
Ribbon cable
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Installing the Digidesign 
SCSI 64 / ATTO EPCI-DC SCSI 
Accelerator Card

To install the ATTO ExpressPCI Dual-Channel SCSI 
Accelerator:

1  Unplug and open your Macintosh computer 
or expansion chassis according to the instruc-
tions included with it. 

2  Release any static electricity by touching the 
power supply, or another grounded item.

3  Remove the ATTO card from the antistatic 
bag, being careful to handle it only by the edges.

4  Line up the ATTO card with the installation 
slot, and slide the card into place gently so the 
PCI connector is aligned with the PCI slot.

5  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI slot.

6  Fasten the card in place using the included 
screw to attach the card bracket to the computer 
mounting bracket.

Digidesign SCSI64 / ATTO EPCI-DC SCSI Accelerator



Flashing SCSI ROM with ATTO 
ExpressPro-Tools

ExpressPro-Tools is supplied with Pro Tools 5.1 
and every ATTO SCSI card, and allows you to 
flash the ROM on the SCSI card. Digidesign 
strongly recommends that the firmware be set 
on SCSI channels where audio storage is con-
nected as follows:

1  Launch ExpressPro-Tools after booting your 
system and mounting all drives.

2  Double-click Media Drive.

3  From the Sync Rate pop-up menu, select 
“20 (10)” (20 MB/sec at 10 MHz).

4  Click “Apply to All” (sets the card for all drive 
IDs on that bus).

5  Repeat if necessary for the other bus.

6  Quit ExpressPro-Tools.

7  Restart you computer.

These settings are optimized for the size and fre-
quency of SCSI transactions demanded by 
Pro Tools. 

Initializing Hard Drives

The following is hard drive initialization infor-
mation for three different scenarios: Pro Tools 
with no interchange, Avid to Pro Tools, and 
Pro Tools to Avid. 

Pro Tools and AVoption do not support 
striped audio drives.
Pro Tools with No Interchange

In installations where Pro Tools will not be rou-
tinely sharing projects with Avid Media Com-
poser systems, ExpressPro-Tools from ATTO 
(provided with Pro Tools 5.1) should be used to 
initialize all audio and video drives. Both HFS 
and HFS+ file systems are supported for audio 
drives. Only HFS is supported for video drives 
(HFS+ has not been fully tested with video 
drives).

Avid to Pro Tools

For projects originating on an Avid Picture Au-
thoring system, such as Media Composer, a sin-
gle HFS drive initialized with either ADU 2.1 or 
later is supported. This drive may contain video 
or audio media files. Pro Tools with AVoption 
supports playback of audio and video tracks 
from a single drive, as long as track count does 
not exceed one stream of AVR77 and a maxi-
mum of eight audio tracks. When this drive is 
used in a Pro Tools session, additional audio 
tracks (beyond those imported from the Avid 
workstation) should not be added, for band-
width reasons.

Drives initialized by Avid Drive Utility 2.1 or 
later as 2-way or 4-way are supported in this sce-
nario. It is recommended that drives be added to 
the SCSI channel dedicated for video to balance 
demands on the SCSI system. Note that 
Pro Tools can recognize a maximum seven 
drives per SCSI channel. 
Chapter 4: Installing AVoption 15
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Pro Tools to Avid

When a drive is being sent from a Pro Tools sys-
tem to an Avid picture workstation, the drive 
should be initialized as HFS using ExpressPro-
Tools. When an Avid system is inheriting files 
from Pro Tools, a “finder copy” of these files 
may be necessary to transfer them from the 
Pro Tools drive to an Avid/AU2 initialized drive. 

If a drive is sent from a Pro Tools system to an 
Avid workstation so that files can be consoli-
dated and copied to that drive for use on 
Pro Tools, the same procedure is required. The 
drive should be initialized as HFS in ExpressPro-
Tools before being mounted on the Avid work-
station.

Media Management

It is recommend that you dedicate one SCSI 
channel to audio drives and one SCSI channel to 
video drives. Doing this will help you to keep 
the data bandwidth balanced on your system 
(and avoid the necessity of constantly moving 
files around to consolidate bandwidth).

If your Pro Tools system is mounting an inter-
change drive originated by an Avid picture 
workstation, it is recommended that this inter-
change drive be installed on the SCSI bus dedi-
cated to video data.

If your Pro Tools system receives an ADU2 drive 
with data from an Avid picture workstation, it 
recommended that you do not record additional 
audio files or tracks onto this drive. 
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AVoption Video Connections

The ABVB Video Cable

AVoption includes a cable that provides nine 
coaxial video connections to connect video and 
sync components of your system to the ABVB 
card.

To connect the ABVB cable to the ABVB card:

1  Remove the ABVB cable from the protective 
plastic bag.

2  Connect the single connector end to the 
matching connector on the ABVB card.

3  Tighten the screws to lock the cable in place.

Video Connectors on the ABVB Cable

GL IN This “Gen Lock” connector is used to con-
nect the ABVB card to an external reference 
video (black burst) source.

CV OUT This connector provides Composite 
Video out. You can use this output to connect 
an NTSC or PAL video monitor for video view-
ing. You can also connect this output to a com-
posite input on your VTR. 

ABVB video connector cable



Y OUT, B-Y OUT, R-Y OUT These connectors pro-
vide Component (RGB) Video outputs. You can 
use these to connect a video reference monitor 
or VTR that has Component Video inputs.

CV IN This input is used to get Composite Video 
from an external source into AVoption. Con-
nect this to your video source.

This connector can also be used in a video loop 
with the USD. The output of your VTR can be 
connected to the Video In connector on the 
USD, then the Video Out connector on the USD 
can be connected to this CV IN cable. You might 
use this connection to “window burn” with the 
USD.

Y IN, B-Y IN, R-Y IN These inputs are used to get 
Component Video signals from an external 
source into AVoption.

To connect a BNC connector:

■ Slide the end of the BNC connector over the 
matching BNC connection, and twist the BNC 
connector clockwise until it locks into place.

To remove a BNC connector:

■ Grip the BNC connector you want to remove 
and twist it counter-clockwise until it comes 
loose.

Many NTSC video monitors include outputs 
that recreate a video input signal. You can 
connect the CV OUT from the ABVB to an 
NTSC monitor, then connect an output 
from the monitor to your VTR to record 
from AVoption. 

BNC connector
USD Connections

The following illustrations show USD connec-
tions. The Universal Slave Driver User’s Guide pro-
vides more specific information about this pe-
ripheral.

Connecting House Sync or 
Black Burst

In most AVoption setups, three black burst or 
“house sync” connections are required: 

• To VIDEO REF in on the USD

• To a video input on your VTR (a video refer-
ence input if available)

• To the GL IN connector from the ABVB cable

Read the documentation for your black burst 
generator for more information.

USD video connections

USD connection to an audio interface

MAC SERIALVIDEO REF VIDEO

IN

OUT

black burst
Serial cable

to Macintosh

VTR out

CV IN (ABVB)

85-264VAC, 47-63HZ, 115 W

SUPER CLOCK (256X)9-PIN  OUT

9-PIN IN / ACC

IN

OUT

to Slave Clock In
(audio interface)
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Connecting a VTR

A VTR can be used to provide video input and to 
record video output from AVoption. In most sit-
uations, there are three connections you need to 
make:

• Connect a black burst or house sync output to 
a video input on your VTR (preferably a refer-
ence video input).

• Connect the ABVB cable’s CV IN and/or Com-
ponent IN connectors to the corresponding 
outputs on your VTR.

• Connect the ABVB cable’s CV OUT and/or 
Component OUT connectors to the corre-
sponding inputs on your VTR.

– or –

• Connect the ABVB cable’s CV OUT and/or 
Component OUT connectors to the corre-
sponding input on an NTSC or PAL video 
monitor, then connect the outputs from this 
monitor to corresponding inputs on your 
VTR.

Connecting an External Video 
Reference Monitor

To connect an external NTSC or PAL video ref-
erence monitor, use the ABVB cable’s Compos-
ite or Component Video outputs.

Centralized Video Switching and 
Routing

Many professional facilities have centralized 
video switching and routing systems. These sys-
tems can be used to route AVoption’s inputs and 
outputs to flexible input sources and output des-
tinations.
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Configuring AVoption with a 
Single VGA Monitor
If you plan to run your Pro Tools AVoption sys-
tem with only one VGA monitor, you will need 
to connect it to the Macintosh video card and 
designate it as the system startup monitor. 

If the ABVB VGA output has defaulted to being 
the system startup monitor, you will need to 
perform the following procedure.

To set the VGA monitor as the startup monitor:

1  Connect your monitor temporarily to the 
ABVB VGA output.

2  Choose Monitors & Sound Control Panel > 
Identify Monitors.

3  Drag the Menu Bar across the top of the mon-
itor icon from the ABVB monitor icon to the 
Macintosh monitor icon. 

4  Drag the Macintosh icon from the middle of 
the ABVB monitor icon to the Macintosh moni-
tor icon.

5  Restart you computer, with your VGA moni-
tor connected to your Macintosh VGA output. 
The monitor will now appear as the system star-
tup monitor. 

Note that the steps above may be necessary 
when you first install AVoption, as well as after 
any time you zap the P RAM of your computer.



Set Color Depth to Millions

Since the VGA output on ABVB cannot be dis-
abled, you will always see two monitors repre-
sented in the Monitors & Sound Control Panel 
(even if you have only one monitor connected 
to the Macintosh). As a result, when launching 
Pro Tools, you may receive the error message, 
“Video engine requires ABVB monitor to be set 
to millions of colors in order to load.”

To avoid this error message, set the Color Depth 
to “Millions” in the Monitor Control Panel.

ABVB’s VGA Output
The ABVB card includes a VGA monitor output, 
which can be used to drive a second VGA mon-
itor. This second monitor is used to display the 
Pro Tools Movie window (see “Window Play-
back” on page 44), without taxing the resources 
of the Macintosh PCI bus.

Configuring Two Monitors

When using two VGA monitors with AVoption, 
you must specify Macintosh monitor as the sys-
tem startup monitor.

To the default monitor:

1  Choose Monitors & Sound Control Panel > 
Identify Monitors.

2  Drag the Menu Bar across the top of the mon-
itor icon to the correct monitor icon. 

To reduce PCI bus traffic, and avoid system 
performance errors, you should display only 
the Movie window on the ABVB monitor. 
Particularly problematic is placing win-
dows partially on both monitors.
3  Drag the Macintosh icon in the middle of the 
monitor icon to the correct monitor icon.

4  Next time you restart your computer, the new 
monitor assignments will take effect. 

Using NTSC and PAL
When switching between NTSC and PAL for-
mats, settings must be changed in three places:

• In the Pro Tools Session Setup window, select 
the correct frame rate (25, 29.97 DF or NDF).

• The USD must be set (and locked) to the re-
spective format (PAL or NTSC).

• If you are going to capture video with AVop-
tion, set the Movie Track to the respective for-
mat (PAL or NTSC). This setting can be 
modified when the Movie Track is armed for 
record. The Pal/NTSC format pop-up panel is 
available in the I/O panel on the Movie Track. 

To see the Pal/NTSC format pop-up panel:

■ Select Display > Edit Window Shows > I/O 
View. 
Chapter 4: Installing AVoption 19
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Sample AVoption Setup 
Diagrams
AVoption & AVoption XL Guide
Sample ABVB video setup
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Video connections for component video, black burst, and external monitor

CH-1 CH-2

External video monitor

Black Burst generator

Video deck

CV OUT (from ABVB)

GL IN (ABVB)

Component video outputs (ABVB)

Video in panel

Video out panel

to Ref Video input
on video deck

to USD / VSD

to Component Video

ABVB cable

inputs (ABVB)
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chapter 5

Installing AVoption XL
This chapter discusses the installation of 
AVoption XL software and hardware.

Installing a NewAVoption XL 
System
If you do not already have currently supported 
Pro Tools hardware installed, you must install 
AVoption XL as a new system. 

To install a new AVoption XL system:

1  Install Pro Tools software using the Pro Tools 
Installer CD-ROM. The first time you launch 
Pro Tools, you are prompted to enter a authori-
zation number, which is included in your TDM 
Software Installation Guide.

2  Install AVoption XL software. See “Installing 
AVoption XL Software” on page 24.

3  Install Pro Tools and AVoption XL hardware. 

• Determine the proper PCI slots for your instal-
lation. See Appendix B, “Slot Configurations 
for AVoption XL.”

• Install Pro Tools hardware using the instruc-
tions in your Pro Tools Hardware Installation 
Guide.

• Install AVoption XL hardware. See “Installing 
AVoption XL Hardware” on page 24.
Installing AVoption XL as an 
Upgrade
If you have currently supported Pro Tools TDM 
hardware installed in your system, then you can 
install AVoption XL as an upgrade. 

To install AVoption XL as an upgrade:

1  Install AVoption XL software. See “Installing 
AVoption XL Software” on page 24.

2  Install AVoption XL hardware. Determine the 
proper PCI slots for your installation using 
Appendix B, “Slot Configurations for 
AVoption XL.” You may need to rearrange 
Pro Tools or other cards that are already in-
stalled. To install the AVoption XL hardware, see 
“Installing AVoption XL Hardware” on page 24.

You must have the latest version of 
Pro Tools (included in the AVoption XL 
package) installed before you install 
AVoption XL.
Chapter 5: Installing AVoption XL 23
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Installing AVoption XL 
Software
AVoption XL includes the following software:

• Pro Tools Installer CD-ROM

• AVoption XL Authorizer floppy disk

AVoption XL is copy protected with a key disk 
system. After you install the software from CD-
ROM, the Authorizer diskette permits you to au-
thorize and use a single copy of AVoption XL. 

AVoption XL software is installed in a specific 
location in your System Folder, and should not 
be moved or altered. The Authorizer diskette 
permits you to reclaim authorization from your 
hard drive if you want to install AVoption XL 
on a different hard drive, or if you want to re-
initialize or format your drive.

To install AVoption XL software:

1  Insert the Pro Tools Installer CD-ROM in your 
CD-ROM drive.

2  Follow the installation instructions to install 
AVoption XL.

To authorize or deauthorize AVoption XL:

1  Insert Authorizer diskette into floppy drive. 
(Pro Tools should NOT be launched during this 
process)

2  Click Authdeauthorizer in the pop-up win-
dow that appears. 

3  Click Set-up Authorizer or Deauthorizer.
AVoption & AVoption XL Guide
4  Choose Remove or Authorize (If you are re-
moving an application and a”?” appears over 
the application icon, indicates that the diskette 
you inserted is not the one you originally used 
to authorize this application. You should see a 
gold key icon. If you continue through the de-
authorization process with a “?” will deautho-
rize the application but not credit an 
authorization back to the diskette for your next 
installation.)

5  Select disk location and click Remove or Au-
thorize. 

6  Quit.

Installing AVoption XL 
Hardware

AVoption XL PCI Slot 
Configurations

To install your AVoption XL hardware, first de-
termine the PCI slots where you will install the 
hardware. For detailed information, see 
Appendix B, “Slot Configurations for 
AVoption XL.”

Audio Hardware

Refer to the TDM Hardware Installation Guide for 
audio hardware installation information. You 
may be required to move hardware that is al-
ready installed to new PCI slot locations in your 
computer or expansion chassis, based on the in-
formation in Appendix B, “Slot Configurations 
for AVoption XL.”



Installing AVoption XL Video 
Hardware

To install AVoption XLvideo hardware:

1  Unplug and open your Magma Expansion 
Chassis according to the instructions included 
with it.

2  Release any static electricity by touching the 
power supply of the chassis, or another 
grounded item.

3  Remove the Digital Media Board from the 
anti-static bag, being careful to handle it only by 
the edges.

4  Line up the Digital Media Board with the in-
stallation slot, and slide the card into place gen-
tly so the PCI connector is lined up with the PCI 
slot. 

5  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI slot.

6  Close the computer or expansion chassis.

PCI card alignment and installation
7  Attach the connector cable from the Digital 
Media Board (connector labeled M) to the Com-
puter connector on the Meridien I/O Box.

Connecting the Digital Media Board to the Breakout Box
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Chapter 5: Installing AVoption XL 25



26
Installing the ATTO EPCI-UL2D 
SCSI Accelerator

To install the ATTO EPCI-UL2D SCSI Accelerator:

1  Unplug and open your expansion chassis ac-
cording to the instructions included with it. 

2  Release any static electricity by touching the 
power supply, or another grounded item.

3  Remove the ATTO card from the antistatic 
bag, being careful to handle it only by the edges.

4  Line up the ATTO card with the installation 
slot, and slide the card into place gently so the 
PCI connector is aligned with the PCI slot.

5  Press down firmly on the card with even pres-
sure. The connector should click into place in 
the PCI slot.

6  Fasten the card in place using the included 
screw to attach the card bracket to the computer 
mounting bracket.

ATTO UL2D LVD SCSI Accelerator
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Flashing SCSI ROM with ATTO 
ExpressProTools

ExpressPro-Tools is supplied with Pro Tools 5.1 
and every ATTO SCSI card, and allows you to 
flash the ROM on the SCSI card. Digidesign 
strongly recommends that the firmware be set 
on SCSI channels where audio storage is con-
nected as follows:

1  Launch ExpressPro-Tools after booting your 
system and mounting all drives.

2  Double-click Media Drive.

3  From the Sync Rate pop-up menu, select 
“20 (10)” (20 MB/sec at 10 MHz).

4  Click “Apply to All” (sets the card for all drive 
IDs on that bus).

5  Repeat if necessary for the other bus.

6  Quit ExpressPro-Tools.

7  Restart you computer.

These settings are optimized for the size and fre-
quency of SCSI transactions demanded by 
Pro Tools. You do not need to apply these set-
tings to the second SCSI card if one is installed 
for video media with AVoption XL.

Initializing Hard Drives

The following is hard drive initialization infor-
mation for three different scenarios: Pro Tools 
with no interchange, Avid to Pro Tools, and 
Pro Tools to Avid. 

Pro Tools and AVoption XL do not support 
striped audio drives.



Pro Tools with No Interchange

In installations where Pro Tools will not be rou-
tinely sharing projects with Avid Media Com-
poser systems, ExpressPro-Tools from ATTO 
(provided with Pro Tools 5.1) should be used to 
initialize all audio and video drives. Both HFS 
and HFS+ file systems are supported for audio 
drives. Only HFS is supported for video drives 
(HFS+ has not been fully tested with video 
drives).

Special Configuration Requirements 

When you want compression levels of 2:1 or 1:1 
(uncompressed), an additional ATTO UL2D or 
EPCI-DC SCSI accelerator is required for video 
storage. With the UL2D configuration, a 2-way 
stripe set across both SCSI channels is required 
for 2:1 capability, and a 4-way stripe across both 
channels is required for 1:1 (uncompressed) ca-
pability. It is not necessary to use this configura-
tion if you want compression of 3:1 or higher, or 
when an EPCI-DC SCSI accelerator is used for 
video storage. 

To install:

1  Connect the drives across the two UL2D SCSI 
channels.

2  Select and create your stripe set using the 
ATTO ExpressRAID software (optional from 
ATTO).

3  Initialize all audio drives using ATTO Ex-
pressPro-Tools. 

Do not use ExpressRAID to initialize your 
audio drives. ExpressRAID is not supported 
with audio drives.
Avid to Pro Tools

For projects originating on an Avid Picture Au-
thoring system, such as Media Composer, a sin-
gle HFS drive initialized with either ADU 2.1 or 
later is supported. This drive may contain video 
or audio media files. Pro Tools with 
AVoption XL supports playback of audio and 
video tracks from a single drive, as long as track 
count does not exceed one stream of video (at a 
compression of 3:1 or higher) and a maximum 
of eight audio tracks.

When this drive is used in a Pro Tools session, 
additional audio tracks (beyond those imported 
from the Avid workstation) should not be 
added, for bandwidth reasons.

Drives initialized by Avid Drive Utility 2.1 or 
later as 2-way or 4-way are supported in this sce-
nario. It is recommended that drives be added to 
the SCSI channel dedicated for video to balance 
demands on the SCSI system. Note that 
Pro Tools can only recognize a maximum seven 
drives per SCSI channel.

Pro Tools to Avid

When a drive is being sent from a Pro Tools sys-
tem to an Avid picture workstation, the drive 
should be initialized as HFS using ExpressPro-
Tools. When an Avid system is inheriting files 
from Pro Tools, a “finder copy” of these files 
may be necessary to transfer them from the 
Pro Tools drive to an Avid/AU2 initialized drive. 

If a drive is sent from a Pro Tools system to an 
Avid workstation so that files can be consoli-
dated and copied to that drive for use on 
Pro Tools, the same procedure is required. The 
drive should be initialized as HFS in ExpressPro-
Tools before being mounted on the Avid work-
station.
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Media Management

It is recommend that you dedicate one SCSI 
channel to audio drives and one SCSI channel to 
video drives. This configuration is adequate for 
AVoption XL with compression levels of 3:1 or 
higher. 

If you want compression levels of 2:1 or 1:1 (un-
compressed), an additional separate dual-chan-
nel SCSI card is required for video drives. These 
configurations require that striped drives are 
split across the SCSI buses. 

If your Pro Tools system is mounting an inter-
change drive originated by an Avid picture 
workstation, it is recommended that this inter-
change drive be installed on the SCSI bus dedi-
cated to video data.

If your Pro Tools system receives an ADU2 drive 
with data from an Avid picture workstation, it 
recommended that you do not record additional 
audio files or tracks onto this drive. 
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AVoption XL Video 
Connections
The following video I/O capabilities are avail-
able with the Meridien I/O Box:

• Inputs for composite, component (Y, R-Y, B-
Y), S-Video, and (optional) SDI.

• Outputs for composite, component (Y, R-Y, B-
Y), S-Video, and (optional) SDI.

• Video Ref input to allow the video to be 
locked to an external source such as house 
sync or a black burst generator. 

Note that only one video input source can be 
used at a time. For more information, see “Re-
cording Video” on page 37.

The Meridien I/O Box can only output from 
either S-Video or Component outputs. You 
must set this option in your Movie Track. 
See “Setting S-Video or Component Output” 
on page 36 for instructions.



Meridien I/O Box
The following sections provide figures and tables that describe the function of the Meridien I/O Box 
video I/O.

Meridien I/O Box Front Panel Indicators

The front panel of the Meridien I/O Box (see Figure 1) has six indicators and a power switch. When 
you turn on the Meridien I/O Box, the indicators turn on and off as it goes through a power-on self-
test (POST). After the POST, the POWER indicator remains lit. 

Some indicators do not light, or do not indicate correctly, when used with AVoption XL (see illustra-
tion). To determine this information, use the indicators on your USD, or your Session Setup window.
Figure 1.  Meridien I/O Box front panel
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Video I/O Connectors
AVoption & AVoption XL Guide
Figure 2.  Meridien I/O Box rear panel showing video connectors
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Table 1. Video I/O Board Identifiers 
Number Label Function

1 COMPONENT Y IN Video Y component input, BNC connector. Connects to ana-
log video output of decks.

2 COMPONENT R-Y IN Video R-Y component input, BNC connector. Connects to 
analog video output of decks.

3 COMPONENT B-Y IN Video B-Y component input, BNC connector. Connects to 
analog video output of decks.

4 COMPONENT Y OUT Video Y component (Betacam) output, BNC connector. Con-
nects to analog video input of decks.

5 COMPONENT R-Y OUT Video R-Y component (Betacam) output, BNC connector. 
Connects to analog video input of decks.

6 COMPONENT B-Y OUT Video B-Y component (Betacam) output, BNC connector. 
Connects to analog video input of decks.

7 SDI IN (optional) Serial digital input, BNC connector. Connects to a serial dig-
ital output from a digital video source.

8 SDI OUT1 (optional) Serial digital output number 1, BNC connector. Connects to 
VTR input, a video monitor, or other serial digital device.



9 SDI OUT2 (optional) Serial digital output number 2, BNC connector. Connects to 
VTR input, a video monitor, or other serial digital device.

10 SDI OUT3 (optional) Serial digital output number 3, BNC connector. Connects to 
VTR input, a video monitor, or other serial digital device.

11 SYSTEM Audio and video I/O connector from the system interface 
board.

12 LTC OUT Sends LTC time code out (not used with AVoption XL).

13 LTC IN Brings LTC time code in (not used with AVoption XL).

14 SLAVE CLOCK OUT Clock output, BNC connector (not used with AVoption XL)

15 S-VIDEO OUT Super-video output, 4-pin connector. Connects to analog 
video input of decks.

16 COMPOSITE OUT3 Composite video output, BNC connector. Connects to analog 
video input of decks or monitor.

17 COMPOSITE OUT2 Composite video output, BNC connector. Connects to analog 
video input of decks or monitor.

18 COMPOSITE OUT1 Composite video output, BNC connector. Connects to analog 
video input of decks or monitor.

19 S-VIDEO IN Super-video input, 4-pin connector. Connects to analog video 
output of decks.

20 COMPOSITE IN Composite video input, BNC connector. Connects to 
analog video output of decks.

21 Video Reference (REF) Black burst or house sync input, BNC connector. Synchro-
nizes the system with the global clock source provided by the 
house sync or black burst generator.

Table 1. Video I/O Board Identifiers(Continued)

Number Label Function
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USD Connections

The following illustrations show USD connec-
tions. The Universal Slave Driver User’s Guide pro-
vides more specific information about this pe-
ripheral.

Connecting House Sync or 
Black Burst

In most AVoption XL setups, three black burst 
or “house sync” connections are required: 

• To VIDEO REF in on the USD

• To a video input on your VTR (a video refer-
ence input if available)

• To the VIDEO REF connector on the Meridien 
I/O Box

Read the documentation for your black burst 
generator for more information.

USD video connections

USD connection to an audio interface

MAC SERIALVIDEO REF VIDEO

IN

OUT

Black Burst
Serial cable

to Macintosh

VTR out

to COMPOSITE VIDEO input

85-264VAC, 47-63HZ, 115 W

SUPER CLOCK (256X)9-PIN  OUT

9-PIN IN / ACC

IN

OUT

to Slave Clock In
(audio interface)
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Connecting a VTR

A VTR can be used to provide video input and to 
record video output from AVoption XL. In most 
situations, there are three connections you need 
to make:

• Connect a black burst or house sync output to 
a video input on your VTR (preferably a refer-
ence video input).

• Connect the Meridien I/O Box Composite IN, 
Component IN, S-Video IN, or SDI IN connec-
tors to the corresponding output or outputs 
on your VTR.

• Connect the Meridien I/O Box Composite 
OUT, Component OUT, S-Video OUT, or SDI 
OUT connectors to the corresponding inputs 
on your VTR.

– or –

• Connect the Meridien I/O Box Composite 
OUT or Component OUT connectors to the 
corresponding input on an NTSC or PAL video 
monitor, then connect the outputs from this 
monitor to corresponding inputs on your 
VTR.

The Meridien I/O Box can only output from 
either S-Video or Component outputs (S-
Video is a type of Component output and 
you must choose which component output 
you want you to use). You must set this op-
tion in your Movie track. See “Setting S-
Video or Component Output” on page 36 
for instructions.



Connecting an External Video 
Reference Monitor

Connect an external NTSC or PAL video refer-
ence monitor to a Composite, Component, S-
Video, or SDI output.

Centralized Video Switching and 
Routing

Many professional facilities have centralized 
video switching and routing systems. These sys-
tems can be used to route AVoption XL’s inputs 
and outputs to flexible input sources and output 
destinations.

Using NTSC and PAL
When switching between NTSC and PAL for-
mats, settings must be changed in three places:

• In the Pro Tools Session Setup window, select 
the correct frame rate (25, 29.97 DF or NDF).

• The USD must be set (and locked) to the re-
spective format (PAL or NTSC).

• If you are going to capture video with 
AVoption XL, set the Movie Track to the re-
spective format (PAL or NTSC). This setting 
can be modified when the Movie Track is 
armed for record. The Pal/NTSC format pop-
up panel is available in the I/O panel on the 
Movie Track. 

To see the Pal/NTSC format pop-up panel:

■ Select Display > Edit Window Shows > I/O 
View. 
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chapter 6

Recording and Adding to the Movie Track
You can capture video files by actually recording 
the video in through the inputs on your ABVB 
connector cable (AVoption) or the inputs on 
your Meridien I/O Box (AVoption XL). You can 
also add files created in a compatible Avid video 
editing and composition program, or previously 
captured in Pro Tools.

The Movie Track
The Movie track holds the video clips you cap-
ture or add into Pro Tools. A Pro Tools session 
with AVoption or AVoption XL can only contain 
one Movie track.
 

Figure 3.  Movie track controls (AVoption)
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To select record drives or choose an AVR or com-
pression ratio, select Display > Edit Window 
Shows I/O view.

To create a new Movie track:

■ Choose Movie> New Movie Track.

The new, empty track appears in the Edit win-
dow. 

Figure 4.  Movie track controls (AVoption XL)
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To name the Movie track:

1  Double-click the Track Name button to open 
the Name and Comments dialog. 

2  Type a name (and any optional comments), 
then click OK.

To delete the Movie track:

1  Select the track by clicking the Track Name 
button in the Edit window.

2  Choose File > Delete Selected Tracks.

To clear all video from the Movie track:

■ Choose Movie > Clear Movie Track.

You cannot change names of clips after they 
have been added or recorded. When added, clips 
retain the name they were given by the original 
workstation (often an Avid editing system). 
When recorded in Pro Tools, the clip name is 
derived from the Movie track’s name. You can 
change the clip name by renaming the Movie 
track.

Setting S-Video or Component 
Output

(AVoption XL Only)

The Meridien I/O Box can output from either 
the S-Video or Component outputs. Composite 
out is always active regardless of whether S-
video or component is selected. This choice 
must be made in the software. Once the choice 
is made in the software, it is then echoed in the 
physical connections you use to output signals.
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To select component video outputs in 
AVoption XL:

1  On the Movie track, click the Track options 
pop-up. See Figure 4 on page 35.

2  Use the Video Output pop-up menu to select 
the outputs you want to use: Component or S-
Video.

Movie Track Options
The Movie track can be viewed in frames or in 
blocks. Frames allow you to see an overview of 
the actual video content in a session. Blocks al-
low you to see where clips begin and end, and 
the names of clips.

Frames

In Frames mode, video data is displayed as pic-
tures in the Movie track. These pictures are com-
puted based on the video image, and scale ac-
cording to your track zoom and height settings. 
They do not provide a frame-accurate reference, 
but allow you to easily find a scene or sequence 
in the Movie track.

Frames do not display properly if you change 
zoom settings during playback. Black frames are 
drawn until playback is stopped. You should 
stop playback before changing zoom settings if 
you want to view frames.

Blocks

Blocks mode displays the Movie track as blocks 
of compositional data. Blocks are outlined wher-
ever clip boundaries exist. These block names 
indicate both the boundaries for clips defined in 

Movie track in Frames mode



a video editing system and separate clips re-
corded into Pro Tools. Names from the original 
clips are retained, and new names are given to 
newly recorded material. For example, two clips 
edited together without any transitions or ef-
fects, and named “House Ext” and “House Int,” 
will appear as two blocks bordering each other 
with those names.

In Blocks mode, you can place the cursor on the 
Movie track, then press Tab to move to the next 
video edit in the track.

To set the view for the Movie track:

■ On the Movie track, select Frames or Blocks 
from the View Options pop-up menu.

Recording Video
You can record multiple video clips to multiple 
locations on a single Movie track.

To set video recording options:

1  To record video, you will first need a Movie 
track. You can use the existing one, or if neces-
sary, create a new one.

2  Select a video format by clicking the Track op-
tions button (see Figure 3 and Figure 4), then se-
lecting Video Format. You can select NTSC or 
PAL format.

3  To select record drives or choose an AVR or 
compression ratio, select Display > Edit Window 
Shows I/O view.

Movie track in Blocks mode
4  Select the video input you are using by click-
ing the Record options button, then selecting 
Video Input. You can select Component or 
Composite input (AVoption and AVoption XL), 
or S-Video or SDI (AVoption XL only).

5  Set the compression level for the video cap-
ture from the Compression Level pop-up menu.

6  Select the target hard drive volumes for the 
video capture. Target volumes capture video in 
order, from the first (top) to the last (bottom). In 
the following illustration, Video-0 captures 
video first, followed by Video-1, then Video-3.
 

As you add or remove volumes from the track, 
the available record time is updated to reflect 
available disk space and compression settings. 
The time displayed is approximate.

Setting the Compression Level (AVoption)

Setting the Compression Level (AVoption XL)

Target Volumes for Video Capture
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To record video:

1  Use your cursor to mark the point from where 
you want to start recording, or to select a range 
of time for the recording. You can make this se-
lection on a Timebase Ruler or on a track. If you 
make this selection on a track, make sure that 
Edit and Timeline selections are linked.

2  Record enable the track by clicking the Record 
Enable button.

3  Click the Record button in the Transport win-
dow to enable recording.

4  Start playing the video source.

5  Click Play in the Transport window to begin 
recording.

6  Click Stop in the Transport window to stop re-
cording.

MachineControl

You can use Digidesign’s MachineControl soft-
ware to remotely control your external video 
deck in sync with your Pro Tools capture. Ma-
chineControl is optional software. Contact your 
dealer for more information.

Blocks mode is recommended when recording 
to the Movie track with MachineControl.

Note that if there are already clips on the 
Movie track, and you record over them, the 
overwritten material will be removed from 
the Movie track (although it will still re-
main intact in its original storage location). 
You can Undo Capture Clip and restore the 
original clips. Refer to “Undo/Redo for 
Video Editing Commands” on page 42 for 
more information.

Command+period (.) will abort a clip cap-
ture in progress and restore the Movie track 
to the original clips. 
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Timebase Correction

Most professional video decks have built-in 
timebase correction. To find out whether or not 
your video deck has built-in timebase correc-
tion, refer to the manufacturer’s documenta-
tion.

AVoption XL requires that all sources be time-
base corrected. AVoption allows you to capture 
video from sources that are not timebase cor-
rected. However, it is recommended that you 
use timebase corrected sources whenever possi-
ble. 

If you are manually capturing video in AVop-
tion that is not timebase corrected, start play-
back of the video deck first to stabilize the sig-
nal. If your configuration does not feature time-
base correction, make sure that your sync 
generator is connected to the external sync or 
reference video input on your video deck, and 
that the deck’s sync selector is set to “external 
sync” or “reference video.”

Capturing with Stationary 
Playhead

If you want to capture video with Scrolling Op-
tions set to “Continuous Scrolling with Play-
head,” AVoption should always be set to Blocks 
mode (as opposed to Frames mode) to avoid per-
formance errors. 

Capturing and Approximate Time 
Left

The approximate record time left in the I/O 
View of the Movie track is an estimate. AVop-
tion and AVoption XL use variable compression 
technologies, and record time varies based on 
the density of the material you are recording. 



Due to these variables, the approximate record 
time left is intended to provide you a rough es-
timate and may not be an accurate reflection of 
your available record time.

The calculation of approximate record time left 
is a conservative estimate based on the highest 
data rate possible for that resolution. The ap-
proximation may vary by several minutes. 

Pro Tools uses the approximate record time left 
value to allocate drive space before recording. 
Because of variables inherent to this estimation 
process, you may find that you have available 
record time left after you thought you had filled 
the drive. 

The record time left is not approximate if you 
are capturing video at a compression rate of 1:1 
(uncompressed) in AVoption XL. Since this 
video is uncompressed, it uses the same data 
rate, regardless of the image. 

Exporting Files from Avid 
Programs
If you already have a project that was created on 
an Avid video authoring system, you can export 
it to an OMF file so the material can be added 
into your AVoption or AVoption XL system. 
This exchange of data between systems is signif-
icantly faster and easier than other methods, 
such as laying-off to tape and re-digitizing. This 
section uses a Media Composer project as an ex-
ample.

DigiTranslator

DigiTranslator is included with your AVoption 
or AVoption XL package. Use DigiTranslator to 
convert OMF files containing video and audio 
into Pro Tools session files. You can also use it to 
export audio material from Pro Tools sessions to 
OMF files for import into other systems. Refer to 
your DigiTranslator documentation for more 
details.

Multi-Streams and AVoption and 
AVoption XL

While some Avid systems support two simulta-
neous streams of real time video, AVoption and 
AVoption XL support only one stream. For this 
reason, it is necessary to make sure that all 
multi-stream transitions and effects are ren-
dered in the Avid sequence before you export.

If you add a sequence into Pro Tools that in-
cludes multi-stream effects, AVoption will sub-
stitute black frames in their place.

AVoption does not require the entire sequence 
to be rendered into one continuous clip (often 
referred to as a “video mixdown” in Avid). 
AVoption and AVoption XL can add complex 
single-stream sequences as multiple clips.

What to Export

When you export from your Avid software, you 
have two choices. You can export the audio and 
video from a project, or you can export the au-
dio or video only.

Video and Audio

If your Media Composer project has video and 
audio in it, export both the video and the audio 
to the OMF file.

Video Only

If you have already started audio post produc-
tion in Pro Tools and you want to replace the 
Movie track with a more recent version, or your 
Avid project has no audio in it, export the video 
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only. Then, if the video in your project changes, 
you can export video only, then add that video 
into AVoption or AVoption XL to stay current 
with the project.

For more information, and specific workflows 
for add and export, see the DigiTranslator Guide 
(DigiTranslator is included in the AVoption and 
AVoption XL packages). 

Preparing for Export in Media 
Composer

To prepare a Media Composer project for OMF 
export and use with AVoption or AVoption XL:

◆ Make sure all media for the project is online. 

◆ Render all effects in advance. OMF export 
does not automatically render effects during the 
process, so if you want to see them, you must 
render effects before you export.

Exporting from Media Composer

To export a file from Media Composer:

1  Select the material to export by doing one of 
the following:

• To select specific tracks in a clip or sequence, 
enable those tracks in the Track Selector 
panel, and disable all others.

• To export part of a clip or sequence, mark IN 
and OUT points to export the marked range 
from a bin or monitor, and select Use Marks in 
the Export Settings dialog box. If you mark an 
IN and no OUT point, the system exports 
from the IN mark to the end of the clip or se-
quence.

• To export the entire clip or sequence, deselect 
the options Use Enabled Tracks and Use Marks 
in the Export Settings dialog box, and make 
sure the topmost track in the project is moni-
tored.
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• If using different drives to transport the 
project, consolidate the project.

2  Choose File > Export.

• Under Export File type, select OMFI composi-
tion. 

• If adding video and audio into an AVoption 
session, select Standard-AIFC and Video and 
Audio options.

• If adding video only into AVoption, select 
Video Only.

• Usually, you should export an OMF file that 
only refers to the audio and video files that al-
ready exist on the hard drives. For this reason, 
it is recommended that you do not export 
With Media.

3  Set the Version to OMFI 2.0.

4  When you finish setting export options, click 
OK.

5  Run DigiTranslator. 

Export File Type dialog in Media Composer



Adding Movie Files with 
AVoption and AVoption XL
With the Add Movie command, you can import 
several clips to a single Movie track, increasing 
your editing capabilities. 

If there are already clips on the Movie track and 
you add over them, the overwritten material 
will be removed from the Movie track. You can 
undo and restore the original clips. Refer to 
“Undo/Redo for Video Editing Commands” on 
page 42 for more information.

Once you have OMF files for your project, you 
are ready to add them. If your OMF file is Video 
Only you can add it as the Movie track in AVop-
tion or AVoption XL. If your OMF file has video 
and audio, you can use OMF Tool to create a 
Pro Tools session from the audio files, then add 
the Movie track separately. 

To create a Pro Tools session with OMF Tool:

1  Launch OMF Tool, and choose 
OMF Tool > Convert OMF to Pro Tools.

2  Select the OMF composition file. 

3  Name the Pro Tools session, and choose 
Pro Tools 4 as the version to save.

4  Set all other options based on your session re-
quirements, and click Save when you are done. 
The resulting file is a Pro Tools session. OMF 
Tool ignores the video information.

You can use DigiTranslator to translate 
video and audio simultaneously. See your 
DigiTranslator documentation for details.
To open your session with AVoption or 
AVoption XL:

1  Choose File > Open Session.

2  Find the Pro Tools session created by OMF 
Tool, select it, and click Open.

To add a video into the Movie track:

1  With a session open, choose Movie > Add 
Movie.

2  Select the OMF file created by the Video Only 
or Video and Audio export, and click OK.

Importing Movies (QuickTime)
You can import a QuickTime movie to a Movie 
track. When you import a movie, it clears the 
Movie track of its contents and replaces it with 
the imported movie. Importing is only recom-
mended if you want to import a QuickTime 
movie, since QuickTime movies take up the 
whole Movie track and cannot be edited with 
other clips. Adding movie clips is recommended 
for editing multiple clips (that are not Quick-
Time). See “Adding Movie Files with AVoption 
and AVoption XL” on page 41.

For more information on QuickTime movies 
and how to import them, see the Pro Tools Refer-
ence Guide.
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Undo/Redo for Video Editing 
Commands
You can undo or redo the single most recent 
video editing command, including Add Movie, 
Clear Selection, Move Clip, Copy Clip, and Clip 
Capture. If there are already video clips on the 
Movie track, and you record or edit over them, 
the overwritten material is removed from the 
Movie track. You can undo the video editing 
command and restore the original clips.

Undo/Redo works only for the single most re-
cent video editing command. You cannot 
undo/redo once a new video editing command 
has been performed or the session has been 
closed and reopened.

To undo the most recent video editing command:

• Choose Movie > Undo.

To redo the command, choose Movie > Redo.

If you have captured, added or moved a clip 
onto a pre-existing clip and consequently trun-
cated it, Undo will also restore the trimmed clip 
to its original length. 

Performance Guidelines
Virtually all testing for AVoption and 
AVoption XL was done with: 

• A baseline of 32 tracks (of 24–bit/48k audio).

• One stream of the highest resolution of video 
data (record or playback) of which the prod-
uct is capable (AVR77 for AVoption and 1:1—
or uncompressed—for AVoption XL). 
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These test configurations generally included 
one drive for every 16 tracks of audio in addition 
to separate storage devices for video. One way to 
achieve higher track counts is to dedicate more 
drives to the audio tracks. 

On a supported configuration, you should be 
able to easily achieve this performance baseline, 
even with a high degree of edit density on each 
track. The higher the edit density, the more 
heavily taxed the storage system.

You may find better results than this baseline, 
since Digidesign’s performance tests are de-
signed to stress the storage subsystem more 
heavily than the average “real world” usage. You 
may be able to continuously record or play back 
64 audio tracks and picture simultaneously.
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Playing and Editing the Movie Track
Video plays back automatically when you play a 
session that includes a Movie track. There are 
several different options for viewing and syn-
chronizing the video and audio tracks.

Movie Online
When the movie is online, the Movie track plays 
along with the audio session. The movie’s frame 
location is updated every time you place your 
cursor in a new location, and the Movie track is 
scrubbed along with the audio tracks. The 
Movie track is also updated whenever you drag 
or nudge an audio region or an automation 
breakpoint. The movie is online by default.

Online Edit and Selection Behavior

When Pro Tools is in Grid mode or set for Loop 
Playback, and the movie is online, Pro Tools will 
always place your cursor or Edit selection on le-
gal frame boundaries. If you make a selection 
that is outside of frame boundaries, or you place 
your cursor outside a frame boundary, Pro Tools 
will move your cursor to the nearest frame 
boundary and play. 
Movie Offline
If you temporarily do not want to view the 
movie or have the movie frame location up-
dated, you can take the movie offline.

This is useful if you are working with audio and 
do not need to see the video.

To put the movie online:

■ Select Movie > Movie Online. 

To take the movie offline:

■ Deselect Movie > Movie Online. 

The keyboard shortcut for Movie Online/Offline 
is Shift+Command+J.
Chapter 7: Playing and Editing the Movie Track 43



44
Playback Viewing Options
Video can be viewed on a separate NTSC or PAL 
video monitor. Video can also be viewed in an 
on-screen window (AVoption only). 

Using a Playback Monitor with 
AVoption

The ABVB video cable includes video outputs to 
connect an NTSC or PAL video monitor. You 
can connect a monitor that has component or 
composite video inputs. 

The video card will display full-screen video on 
the playback monitor.

To connect a playback monitor:

■ Connect the composite output or the compo-
nent outputs from the ABVB cable to the proper 
input or inputs on the back of your video mon-
itor.

Using a Playback Monitor with 
AVoption XL

The Meridien I/O Box includes video outputs to 
connect an NTSC or PAL video monitor. You can 
connect a monitor that has component, com-
posite, S-Video, or SDI video inputs. 

The video card will display full-screen video on 
the playback monitor.

The Meridien I/O Box can only output from 
either S-Video or Component outputs (com-
posite out is always active). You must set 
this option in your Movie track. See “Setting 
S-Video or Component Output” on page 36 
for instructions.
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To connect a playback monitor:

■ Connect a composite output, the component 
outputs, the S-Video output, or and SDI output 
from the Meridien I/O Box to the proper input 
or inputs on the back of your video monitor.

Window Playback 

(AVoption Only)

Select Windows > Show Movie Window to view 
the Movie track in a window on your computer 
screen. This window will display the video in 
real time. You can resize or move this window 
around your screen when playback is stopped.

The Movie window will give you the best perfor-
mance when it is displayed on a monitor con-
nected to the ABVB VGA monitor output. With 
a monitor connected to your Macintosh graph-
ics accelerator, performance will not be optimal, 
and may not work at all.

Movie window (AVoption)

You cannot view the video input signal in a 
window. In order to view video input, you 
must connect an external monitor to the 
Composite or Component outputs of the 
ABVB card.



If the Movie window is partially blocked by an-
other window on your screen, playback will 
slow or “stutter” as your computer’s CPU at-
tempts to display the video.

Movie window size and position are saved with 
your session.

To show the Movie window:

■ Choose Windows > Show Movie Window.

To resize the Movie window:

■ When playback is stopped, click the lower 
right corner of the Movie window and drag to 
shrink or enlarge the window.

Movie Aspect Ratio

(AVoption Only)

You can set the Movie window to automatically 
snap to one of two window aspect ratios (4x3 or 
16x9), or to allow unconstrained resizing.

By constraining the aspect ratio, you can see a 
more accurate on-screen representation of the 
final video. Use 4:3 for video destined for televi-
sion, and use 16:9 for wide screen film-format 
viewing.

To set the Movie window aspect ratio:

1  Choose Movie > Show Movie window.

2  Choose Movie > Movie Window Aspect Ratio.

3  Choose 4:3, 16:9, or unconstrained as the as-
pect ratio.
Moving the Movie Track or 
Video Clips
You can use the Move Clip command to spot 
the entire Movie track, or individual video clips, 
to a new SMPTE frame location. When you 
move the Movie track, the whole track or se-
quence is moved to the new frame location you 
specify. When you move a clip, it is moved to 
the new location within the Movie track.

You cannot have multiple QuickTime clips on a 
Movie track.

If you move a clip in which a sync point was pre-
viously created, the sync point will maintain its 
position within the clip. For more information 
on understanding, creating, identifying and re-
moving sync points, see the Pro Tools Reference 
Guide.

To spot the entire Movie track to a new frame 
location:

1  Set the Main Timebase display to Time Code 
using the pop-up menu.

2  Enable Spot mode by clicking the Spot button.

Note that if there are already clips on the 
Movie track, and you edit over them, the 
overwritten material will be removed from 
the Movie track. You can undo Move Clip 
and restore the original clips. For more infor-
mation, see “Undo/Redo for Video Editing 
Commands” on page 42.
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3  Shift-click the Movie track with the Grabber 
tool.

4  In the Spot dialog that appears, specify a new 
SMPTE frame number for the start of the Movie 
track. In this dialog, you can press plus or minus 
on the numeric keypad, enter a number, and 
press the Enter key to add or subtract that num-
ber of frames from the currently selected time 
field.

5  Click OK when you are done.

To spot a video clip to a new frame location:

1  Set the Main Timebase display to Time Code 
using the pop-up menu.

2  Enable Spot mode by clicking the Spot button.

3  Click the clip on the Movie track with the 
Grabber tool.

4  In the Spot dialog, specify a new SMPTE frame 
number for the start of the clip. In this dialog, 
you can press plus or minus on the numeric key-
pad, enter a number, and press the Enter key to 
add or subtract that number of frames from the 
currently selected time field.

5  Click OK when you are done.
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Copying Video Clips
You can copy video clips to a new SMPTE frame 
location within the Movie track. 

To copy a video clip to a new frame location:

1  Set the Main Timebase display to Time Code 
using the pop-up menu.

2  Enable Spot mode by clicking the Spot button.

3  Option-click the clip on the Movie track with 
the Grabber tool. 

4  In the Spot dialog, specify a new SMPTE frame 
number for the start of the clip. In this dialog, 
you can press plus or minus on the numeric key-
pad, enter a number, and press the Enter key to 
add or subtract that number of frames from the 
currently selected time field.

5  Click OK when you are done.

Clearing Selected Video Clips
You can clear material from the Movie track. 

To clear selection: 

1  Drag with the Selector in the Movie track to 
select the material you want to clear. You can 
also double-click to select an entire existing 
video clip.

2  Choose Movie > Clear Selection.



Sync Points
Sync points are used when a point within a re-
gion must be aligned to the Grid or to a particu-
lar SMPTE or bar and beat location. This capabil-
ity is important editing music and sound effects 
for video and film work. 

Once you have a sync point identified, you can 
spot edit the clip based on that sync point. For 
more information on moving video clips, see 
“Moving the Movie Track or Video Clips” on 
page 45.

To identify a sync point:

1  Set the Edit mode to Spot mode.

2  With the Selector, click in the region at the 
point where you want to define the sync point. 

3  Choose Edit > Identify Sync Point. A small 
down arrow appears at the bottom of the region, 
indicating the location of the sync point. 

To remove a sync point, select the entire region 
with the sync point and choose Edit > Remove 
Sync Point. 

For more information on sync points, see the 
Pro Tools Reference Guide. 
Locking the Movie Track
Ifyou want to permanently associate your video 
clips with a certain location on your Movie 
track, you can lock it in place so it will not be 
moved accidentally. 

To lock the Movie track:

1  With the Grabber, select the Movie track.

2  Choose Edit > Lock Region/Unlock Region.

When the Movie track is locked, a small lock 
icon appears in the track, indicating that the 
Movie track has been locked and cannot be 
moved. If you attempt to move a locked region, 
you will receive an error message.

Once a Movie track is locked, you cannot Add 
video clips to it (without first unlocking it).

Locking the Movie track only prevents it from 
being moved. Recording still affects the clips in 
the Movie track.

You can also lock the Movie track by triple-
clicking in the Movie track (to select all 
clips) and pressing Command+L.
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appendix a

Slot Configurations for AVoption

This appendix documents slot configurations for AVoption systems, with and without expansion 
chassis.

9500/9600 without Expansion Chassis

Slot Card

CPU Slot 1 Macintosh Monitor card

CPU Slot 2 d24 or MIX Core card

CPU Slot 3 MIX Farm or DSP Farm cards (if any)

CPU Slot 4 SCSI HBA 

CPU Slot 5 Janus Advanced JPEG card

CPU Slot 6 ABVB card

CPU speed of 300 MHz or higher recommended.
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9500/9600 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V
SBS DD2, 240–2–2, or 240–2–201

Slot Card

CPU Slot 1 Empty

CPU Slot 2 Chassis Host card

CPU Slot 3 Macintosh Monitor card

CPU Slot 4 SCSI HBA

CPU Slot 5 Janus Advanced JPEG card

CPU Slot 6 ABVB card

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 d24 or MIX Core card

Chassis Slots 2–10 Additional Pro Tools cards (9 maximum)

Chassis Slots 10–13 Empty

CPU speed of 300 MHz or higher recommended.

Expansion chassis slots are numbered sequentially from left to right. These chassis require a 
supplemental cooling fan kit.
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9500/9600 with 7-Slot Expansion Chassis
SBS DD22–1 or 2101–00–2 (with IBM Bridge Chips)

Slot Card

CPU Slot 1 Empty

CPU Slot 2 Chassis Host card

CPU Slot 3 Macintosh Monitor card

CPU Slot 4 SCSI HBA

CPU Slot 5 Janus Advanced JPEG card

CPU Slot 6 ABVB card

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 d24 or MIX Core card

Chassis Slots 2–7 Additional Pro Tools cards (6 maximum)

CPU speed of 300 MHz or higher recommended.

Expansion chassis slots are numbered sequentially from left to right. These chassis require a 
supplemental cooling fan kit.
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Blue & White G3 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V 

Slot Card

CPU Slot 1 Chassis Host card

CPU Slot 2 Empty

CPU Slot 3 SCSI HBA

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 ABVB card

Chassis Slot 2 Janus Advanced JPEG card

Chassis Slot 3 d24 or MIX Core card

Chassis Slots 4–12 Additional Pro Tools cards (9 maximum)

Chassis Slot 13 Empty

Expansion chassis slots are numbered sequentially from left to right. These chassis require a 
supplemental cooling fan kit.
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G4 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma model PCI–13–RX–400V

Slot Card

CPU Slot 1 SCSI HBA 

CPU Slot 2 Chassis Host card

CPU Slot 3 Empty

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 ABVB card

Chassis Slot 2 Janus Advanced JPEG card

Chassis Slot 3 d24 or MIX Core card

Chassis Slots 4–12 Additional Pro Tools cards (9 maximum)

Chassis Slot 13 Empty

Expansion chassis slots are numbered sequentially from left to right. These chassis require a 
supplemental cooling fan kit.
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G4 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)
Magma PCI–13R

Slot Card

CPU Slot 1 Chassis Host card

CPU Slot 2 Empty

CPU Slot 3 SCSI HBA (Audio)

Chassis Backplane Slot Chassis Controller card

Chassis Slot 1 d24 MIX or Core card

Chassis Slot 2–6 Additional Pro Tools cards (5 maximum)

Chassis Slot 7 ABVB card

Chassis Slot 8 Janus Advanced JPEG card

Chassis Slot 9 SCSI HBA (Video)

Chassis Slots 10–13 Empty

Expansion chassis slots are numbered sequentially from right to left. These chassis require a 
supplemental cooling fan kit.
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appendix b

Slot Configurations for AVoption XL

This appendix documents slot configurations for AVoption XL systems, with and without expansion 
chassis. 

9500/9600 without Expansion Chassis

Slot Card

CPU Slot 1 Macintosh Monitor card

CPU Slot 2 d24 or MIX Core card

CPU Slot 3 MIX Farm or DSP Farm cards (if any)

CPU Slot 4 MIX Farm or DSP Farm cards (if any)

CPU Slot 5 SCSI HBA 

CPU Slot 6 Avid Digital Video Board

CPU speed of 300 MHz or higher recommended. Supports 3:1 video compression or higher (no 
2:1 or 1:1).
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9500/9600 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma model PCI–13–RX–400V

Slot Card

CPU Slot 1 Macintosh Monitor card

CPU Slot 2 Chassis Host card

CPU Slot 3 Empty

CPU Slot 4 SCSI HBA (Audio)

CPU Slot 5 Empty

CPU Slot 6 Empty

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 SCSI HBA (Video)

Chassis Slots 2–3 Empty

Chassis Slot 4 Avid Digital Video Board

Chassis Slot 5–7 Empty

Chassis Slot 8 d24 or MIX Core card

Chassis Slots 9–13 Additional Pro Tools cards (6 maximum)

CPU speed of 300 MHz or higher recommended.

Expansion chassis slots are numbered sequentially from left to right. These chassis require a 
supplemental cooling fan kit.
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Blue & White G3 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V
SBS DD2, 240–2–2, or 240–2–201

Slot Card

CPU Slot 1 Chassis Host card

CPU Slot 2 Empty

CPU Slot 3 SCSI HBA (Audio)

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 SCSI HBA (Video)

Chassis Slots 2–3 Empty

Chassis Slot 4 Avid Digital Video Board

Chassis Slots 5–7 Empty

Chassis Slot 8 d24 or MIX Core card

Chassis Slots 9–13 Additional Pro Tools cards (6 maximum)

Expansion chassis slots are numbered sequentially from right to left. These chassis require a 
supplemental cooling fan kit.
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Blue & White G3 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)
Magma PCI–13R

Slot Card

CPU Slot 1 Chassis Host card

CPU Slot 2 Empty

CPU Slot 3 SCSI HBA (Audio)

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 d24 or MIX Core card

Chassis Slots 2–6 Additional Pro Tools cards (6 maximum)

Chassis Slot 7 Avid Digital Video Media Board

Chassis Slot 8 SCSI HBA (Video)

Chassis Slots 9–13 Empty

Expansion chassis slots are numbered sequentially from right to left. These chassis require a 
supplemental cooling fan kit.
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G4 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers lower than NB0600100C)
Magma PCI–13–RX–400V

Slot Card

CPU Slot 1 SCSI HBA (Audio)

CPU Slot 2 Chassis Host card

CPU Slot 3 Empty

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 SCSI HBA (Video)

Chassis Slots 2–3 Empty

Chassis Slot 4 Avid Digital Video Board

Chassis Slots 5–7 Empty

Chassis Slot 8 d24 or MIX Core card

Chassis Slots 9–13 Additional Pro Tools cards (6 maximum)

Expansion chassis slots are numbered sequentially from right to left. These chassis require a 
supplemental cooling fan kit.
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G4 with 13-Slot Expansion Chassis
Pro Tools Expansion Chassis (serial numbers higher than NB0600100C)
Magma PCI–13–RX–400V

Slot Card

CPU Slot 1 Chassis Host card

CPU Slot 2 Empty

CPU Slot 3 SCSI HBA (Audio)

Backplane Chassis Slot Chassis Controller card

Chassis Slot 1 d24 or MIX Core card

Chassis Slots 2–6 Additional Pro Tools cards (6 maximum)

Chassis Slot 7 Avid Digital Video Media Board

Chassis Slot 8 SCSI HBA (Video)

Chassis Slots 9–13 Empty

Expansion chassis slots are numbered sequentially from right to left. These chassis require a 
supplemental cooling fan kit.
AVoption & AVoption XL Guide
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